
 MODULUL 5.3.

 BAZELE UTILIZĂRII APLICAŢIILOR PENTRU PREZENTĂRI 
ELECTRONICE; APLICAŢIA IMPRESS DIN OPENOFFICE 

1



CUPRINS

5.6. Formatare diapozitiv şi prezentare ...............................................................................................3
5.6.1. Aplicarea unui design prezentării ..................................................................................................3
5.6.2. Modificarea culorii de fundal pentru un diapozitiv .......................................................................4

5.7. Imagini, diagrame, tabele, obiecte diverse ...................................................................................5
5.7.1. Inserarea unei imagini într-un diapozitiv .......................................................................................5
5.7.2. Inserarea şi prelucrarea diagramelor ..............................................................................................5
5.7.3. Crearea şi prelucrarea unui tabel .................................................................................................. 6
5.7.4. Obiecte desenate ............................................................................................................................7
5.7.4.1. Desenarea diferitelor forme predefinite ..................................................................................... 7
5.7.4.2. Modificarea formelor desenate ...................................................................................................9
5.7.4.3. Gruparea obiectelor .................................................................................................................. 11
5.7.4.4. Combinarea obiectelor şi construirea formelor..........................................................................12

5.8. Efecte asociate unei prezentări …................................................................................................15
5.8.1. Aplicarea efectelor de animaţie textului şi obiectelor ..................................................................15
5.8.2. Adăugarea efectelor de tranziţie între diapozitive .......................................................................16
5.8.3. Lansarea unei prezentări – Slide Show ........................................................................................17

5.9. Listarea ..........................................................................................................................................18 
5.9.1. Listarea unei prezentări ............................................................................................................... 18
5.9.2. Listare Handouts, Notes, Outline ................................................................................................ 18 

2



5.6. Formatare diapozitiv şi prezentare 

OpenOffice.org Impress  este prevăzut cu numeroase modele de design predefinite -  design 
template pe care le puteţi aplica prezentării pentru a-i da un aspect profesional. 

5.6.1. Aplicarea unui design prezentării 
Fiecare diapozitiv într-o prezentare este exact ca un diapozitiv de tip  master. Un  diapozitiv master  
determină stilul de formatare al textului pentru titlu şi design-ul de fundal – background-ul pentru 
toate diapozitive

• Aplicarea unui nou slide master: 

1. Selectaţi Format – Slide Design 
Se deschide caseta  Slide Design  care deschide o listă de şabloane de tip design care pot fi aplicate 
diapozitivelor prezentării. le ce folosesc acest slide master. 

2. Clic pe butonul Load – pentru a adăuga şi alte modele design la lista deschisă. 
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3. În caseta Categories selectaţi o categorie de slide design 

4. În caseta Templates selectaţi un tip de şablon cu un design pe care vreţi să-l aplicaţi. Clic pe butonul 
More pentru a previzualiza şablonul şi selectaţi Preview 

5.  Pentru  a  aplica  şablonul  ales  pentru  design  numai  pentru  diapozitivul  curent,  debifaţi  caseta 
Exchange background page apoi click OK. 

6. Pentru a aplica şablonul ales pentru design numai pentru diapozitivul curent, bifaţi caseta Exchange 
background page apoi click OK 

5.6.2. Modificarea culorii de fundal pentru un diapozitiv 

Fundalul  (background)  ataşat  unui  diapozitiv  poate  fi  o  culoare  uniformă,  o  culoare  în 
degrade, o textură, o haşură. 
Pentru a modifica fundalul parcurgeţi paşii: 
1. Selectaţi diapozitivul pentru care se va aplica o nouă culoare de fundal. 

2.  Alegeţi  Format  → Page  → Background,  deschideţi  lista  de  variante  Fill,  se  afişează  caseta 
următoare: 

3. Se alege o categorie de umplere, de exemplu Color; 

4. Din lista de culori care se deschide alegeţi o culoare; 

5.  Pentru a aplica culoarea de fundal aleasă tuturor diapozitivelor prezentării  răspundeţi  cu  Yes  la 
întrebarea de mai jos şi cu No dacă vreţi să aplicaţi culoarea numai pentru diapozitivul curent. 

Ce aţi învăţat în acest capitol? 
• Cum se aplică un şablon de tip design unui diapozitiv sau unei prezentări. 

• Cum să modificaţi culoarea de fundal unui diapozitiv sau unei prezentări. 
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5.7. Imagini, diagrame, tabele, obiecte diverse 

5.7.1. Inserarea unei imagini într-un diapozitiv 

Inserarea  unei  imagini  (picture) 
într-un  diapozitiv  se  poate  realiza  prin 
două metode: 
1.  Alegeţi  un  şablon  pentru  aspect 
diapozitiv - Slide Layout - care să conţină 
pictograma 

• În diapozitiv efectuaţi un dublu clic 
pe aceasta.  Se afişează o fereastra 
Insert picture: 

• Selectaţi locul pe disc unde se află 
imaginea de inserat. 

• Clic pe imaginea dorită, după care 
clic pe Open pentru a o insera. 

2.  Folosiţi  comanda 
Insert→Picture→From 
File. Se deschide aceeaşi fereastră  Insert picture pentru a selecta imaginea dorită, după care clic pe 
Open pentru a o insera. 

5.7.2. Inserarea şi prelucrarea diagramelor 

Aplicaţia la care apelează  OpenOffice.org Impress  pentru creare, modificare diagrame este 
OpenOffice.org Graph. Inserarea unei diagrame – graph într-un diapozitiv se poate realiza prin două 
metode: 
1. Alegeţi un şablon pentru Aspect diapozitiv - Slide Layout - care să conţină pictograma 

• În diapozitiv efectuaţi un dublu clic pe pictograma de Chart. Se afişează o diagramă creată pe 
baza unor date implicite, în fereastra de aplicaţie Graph. Datele care stau la baza graficului se 
află într-un tabel numit foaie de date (datasheet), pe care-l afişaţi prin Edit → Chart Data. 
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• Introduceţi propriile date în foaia de date sau puteţi importa date din OpenOffice.org Calc sau 
să lipiţi date din alte programe. 

• Clic în exteriorul graficului, se revine în modul de vizualizare anterior, Normal, graficul din 
diapozitiv este creat pe baza datelor noi introduse. 

2. Lansaţi  Insert→ Object → OLE Object. Se deschide fereastră  Insert OLE Object  unde selectaţi 
opţiunea Create new şi respectiv OpenOffice.org 2.2 Chart. 

Se deschide fereastra aplicaţiei pentru realizare grafice şi urmaţi paşii de la punctul 1 pentru a 
crea  diagrama  dorită.  Modificarea  şi  formatarea  diagramelor  se  execută  cu  ajutorul  comenzilor 
specifice aplicaţiei pentru grafice. 

5.7.3. Crearea şi prelucrarea unui tabel 

Aplicaţia la care apelează OpenOffice.org Impress pentru crearea, modificarea tabelelor este 
o aplicaţie de tip spreadsheet OpenOffice.org Calc, aplicaţie învăţată mai înainte. Inserarea unei tabel 
într-un diapozitiv se poate realiza prin două metode: 

1. Alegeţi un şablon pentru aspect diapozitiv (slide layout) care să conţină pictograma 

• În diapozitiv efectuaţi un dublu clic pe pictograma de tabel. Se afişează o foaie de date goale 
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specifică aplicaţiei OpenOffice.org Calc, care se deschide odată cu aceasta 

• Introduceţi datele tabelului pe care doriţi să-l obţineţi 

• Clic în exteriorul foii de date şi se revine la vederea normală a diapozitivului cu tabelul creat  
anterior ca obiect. Mai jos aveţi un exemplu de tabel. 

2.  Lansaţi  Insert→ Object→ OLE Object. Se deschide fereastră  Insert OLE Object  unde selectaţi 
opţiunea Create new şi respectiv OpenOffice.org Spreadsheet. 

Se deschide o foaie de date goală, ca şi în metoda de la punctul  1, unde introduceţi datele 
tabelului, clic în exterior se revine la diapozitiv-ul curent. 

Modificarea  şi  formatarea  tabelelor  se  execută  cu  ajutorul  comenzilor  specifice  aplicaţiei 
OpenOffice.org Calc. 

5.7.4. Obiecte desenate 

Aplicaţia OpenOffice.org 2.2 Impress foloseşte mai multe instrumente de desenare care sunt 
valabile şi în celelalte produse OpenOffice.org. Fiecare obiect desenat are asociat un set de proprietăţi 
care pot diferi de la un obiect la altul. 

Pentru crearea formelor de desenare se va afişa bara de desenare,  Drawing toolbar dacă nu 
este vizibilă, lansând View → Toolbars → Drawing 

Cu ajutorul butoanelor de pe bara Drawing puteţi să adăugaţi diferite forme – shapes, text, referiri 
de tip callouts în diapozitivele din prezentare. 

5.7.4.1. Desenarea diferitelor forme predefinite 

În bara de instrumente de desenare executaţi un clic pe butonul de comandă corespunzător 
obiectului formă pe care vreţi să-l desenaţi, astfel alegeţi butonul de desenat: 

1. linie Line 

2. săgeată Line ends with Arrow 

3. dreptunghi Rectangle - 
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4. elipsă Ellipse 

5. casetă text Text 

6. o formă predefinită din categoriile: Curve, Conector, Basic Shapes, Symbol Shapes, Block Arrows,  
Flowchats, Callouts, Stars. 

• Executaţi clic într-un loc în diapozitiv unde va fi plasat colţul stânga sus a formei, care se va 
desena, cu butonul mouse-ului apăsat se deplasează cursorul spre colţul dreapta jos ce va defini 
dimensiunea formei. 

Dacă la această acţiune se asociază şi tasta Shift apăsată, se va obţine o forma regulată, exemplu: în 
loc de elipsă, un cerc; în loc de dreptunghi un pătrat. 

Prezentarea categoriilor de obiecte desenate– forme predefinite 
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Exemplu de desenare a unei forme – Polygon - din categoria Curve 
1. clic pe butonul Curve şi alegeţi comanda Polygon 

2. desenaţi o linie frântă dintr-o serie de segmente de linie 

3. dublu clic pentru a încheia procesul de desenare linii (nu se închide fereastra) 

4. pentru a crea o formă închisă, poligon, dublu clic pe punctul de start al liniei frânte 

5.7.4.2. Modificarea formelor desenate 

Pentru modificarea proprietăţilor de umplere cu o anumită culoare, pentru un tip şi culoare 
pentru linia de contur se foloseşte bara de instrumente Line and Filling: 

• Modificarea culorii de umplere 

1. Clic pe forma de desenare 

2. Deschideţi lista de oferte de umpleri 
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3. Alegeţi o variantă, exemplu Color, şi clic pe culoarea dorită 

4. Se modifică proprietăţile de culoare de umplere ale obiectului formă selectat 

• Modificarea culoare de linie şi tip de linie 

1. Selectaţi forma de desenare de modificat 

2. Alegeţi tipul de line dorit din lista Line Style 

3. Alegeţi culoarea de linie dorită din lista de culori Line Color 

4. Se modifică proprietăţile de linie ale obiectului formă selectat 

• Redimensionarea formelor de desenare 

1.  Clic  pe  forma  de  modificat  dimensiunea.  Apare  forma  încadrată  într-un  dreptunghi  imaginar 
prevăzut cu opt marcaje. 

2. Poziţionaţi mouse-ul pe unul din ele, până ce acesta ia forma cursorului de săgeată dublă. 

3. Executaţi un clic în acel moment şi trageţi în direcţia dorită pentru mărirea sau micşorarea formei. 

• Aşezarea în ordine a formelor de desenare 
Dacă aveţi mai multe obiecte desenate şi vreţi să le aşezaţi într-o anumită ordine, apelaţi la grupul de 
comenzi de aranjare în stivă, prin butonul  Arange, de pe bara de desenare, care vă oferă mai multe 
posibilităţi: 
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- In front of object – în faţa unui obiect 

- Bring to Front – în faţa tuturor obiectelor 
din stivă 

- Bring Forward – aducerea obiectului într-
un plan mai în faţă în stivă 

-  Send  to  Back  –  în  spatele  tuturor 
obiectelor din stivă 

-  Send  Backward  –  trimiterea  obiectului 
într-un plan mai în spate în stivă 

- Behind object – în spatele obiectului 

Paşii pe care trebuie să-i faceţi în schimbarea poziţiei unui obiect faţă de celelalte cu care se 
suprapune total sau parţial, sunt următorii: 
- Selectaţi obiectul pe care vreţi să-l mutaţi în relaţie cu un alt obiect, exemplu obiect stea de mai jos. 

- Alegeţi una din comenzile prezentate mai sus, care este potrivită, exemplu Behind Object, pentru a-l 
trimite în spatele formei săgeată. 

- Selectaţi cu noua formă de cursor obiectul faţă de care să se aşeze forma stea 

- Veţi obţine figura de mai jos: 

5.7.4.3. Gruparea obiectelor 

Puteţi combina mai multe obiecte întrun grup dacă acestea formează un singur obiect. Puteţi 
muta şi transforma toate obiectele din grup ca pe un singur element. De asemenea puteţi schimba 
proprietăţile (de exemplu, dimensiune de linie, culoare de umplere) tuturor obiectelor din grup ca unui 
singur obiect sau fiecărui obiect ce aparţine grupului.  Pentru a grupa două sau mai multe obiecte 

11



procedaţi astfel: 
1. Selectaţi obiectele pe care vreţi să le grupaţi (cu ajutorul tastei SHIFT adăugaţi la selecţie două sau 
mai multe obiecte) 

2. Lansaţi comanda Group (Grupare) din meniul de context afişat la clic dreapta mouse pe selecţie. 

5.7.4.4. Combinarea obiectelor şi construirea formelor 

• Combinarea obiectelor 2D 

1. Selectaţi două sau mai multe obiecte (folosiţi tasta SHIFT pentru a 
selecta mai multe obiecte) 

2.  Clic dreapta mouse, se deschide meniul de context de unde lansaţi 
comada Combine (Combină) 

Notă: Obiectul obţinut în urma combinării ia proprietăţile celui mai de 
jos obicet din stivă. În zona în care se suprapun obiectele apare gaură. 

În imaginea de mai jos aveţi în partea stângă obiectele necombinate, iar 
în partea dreaptă obiectele combinate. 

• Construirea formelor (Shapes) 
Puteţi  construi  forme  prin  folosirea  comenzilor  Merge  (Unire),  Subtract  (Scădere)  şi  Intersect  
(Intersecţie) pentru două sau mai multe obiecte. Formele construite iau proprităţile celui mai de jos 
obiect din stivă. 
Pentru a constru o formă (shape) urmaţi paşii: 
1. Selectaţi două sau mai multe obiecte 3D 

2. Clic dreapta mouse, se deschide meniul de context, deschideţi grupul de comenzi Shapes de unde 
lansaţi una din comenzile: 

- Merge 

- Subtract 

- Intersect. 

12



În  imaginea  de  mai  jos  aveţi  în  partea  stângă  obiectele  originale,  iar  în  partea  dreaptă  obiectele 
obţinute prin comanda Merge. 

Se observă că în urma lansării comenzii Merge au fost adăugate suprafeţele obiectelor selectate 
la cel mai de jos obiect din stivă. 

În imaginea de mai jos aveţi în partea stângă obiectele originale, iar în partea dreaptă obiectele 
obţinute prin comanda Subtract. 

Se observă că în urma lansării comenzii Subtract a fost extrasă suprafaţa obiectelor selectate 
din cel mai de jos stânga obiect din stivă. 

În imaginea de mai jos aveţi în partea stângă obiectele originale, iar în partea dreaptă obiectele 
obţinute prin comanda Intersect. 

Suprafaţa  suprapusă  a  obiectelor  selectate  crează  o  nouă  formă  cu  ajutorul  comenzii  
Intersect. Restul suprafeţelor sunt îndepărtate. 
Notă:  În  afară  de  obiectele  pe  care  le  propune  aplicaţia  Impress  ca  elemente  componente  ale 
diapozitivelor prezentării,  acestea mai pot conţine informaţii  şi  din alte aplicaţii.  De exemplu text 
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prelucrat cu un procesor de texte precum Writer, tabele lucrate într-un produs tabelar – Calc, desene 
realizate  cu  programe  specializate,  etc.  Una  din  metodele  copierii  acestor  tipuri  de  informaţii  în 
diapozitivele unei prezentări este următoarea: 
- selectaţi informaţia pe care vreţi s-o copiaţi (textul dintr-un document Writer; tabelul dintr-o foaie de 
date Calc), apoi lansaţi comanda de copiere 

- selectaţi diapozitivul unde vreţi să lipiţi informaţia, apoi lansaţi comanda de lipire. 

Ce aţi învăţat în acest capitol? 

• Cum se inserează o imagine în diapozitiv. 

• Cum se inserează o diagramă în diapozitiv. 

• Cum se foloseşte interfaţa aplicaţiei de tip spreadsheet pentru introducere de date. 

• Cum se crează un tabel. 

• Cum se desenează obiecte cu instrumentele de desenare. 

• Cum se formatează aceste obiecte. 

• Cum se aşează în ordinea dorită un obiect faţă de altul. 

• Cum se grupează obiectele. 

• Cum se combină şi construiesc formele. 
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5.8. Efecte asociate unei prezentări 

5.8.1.  Aplicarea  efectelor  de  animaţie  textului  şi 
obiectelor 

Aveţi posibilitatea de a aplica efecte de animaţie textelor, 
reprezentărilor  grafice,  diagramelor  şi  altor  obiecte  din 
diapozitive pentru a atrage atenţia asupra punctelor importante. 
Acestea sunt vizibile la lansarea prezentării – Slide Show 

• Aplicarea unui efect de animaţie unui obiect: 

1.  În modul de vizualizare  Normal,  selectaţi  obiectul  pe care 
vreţi să-l animaţi. 

2.  Alegeţi  Slide  Show  →  Custom  Animation,  se  deschide 
panoul de activităţi corespunzător. 

3. Clic pe butonul Add, şi apoi din lista de efecte propuse alegeţi 
un efect de animaţie, apoi clic pe OK. 

Efecte de animaţie: 

-  Entrance  –  efecte  ce  introduc  obiectul  în 
diapozitiv. 

- Emphasis  – efecte ce se aplică asupra textului 
din substituenţi. 

- Exit - efecte ce elimină obiectul din diapozitiv. 

- Motion paths – efecte care duc la deplasarea în 
diapozitiv  a  obiectului  respectiv  pe  diverse 
traiectorii 

Puteţi aplica oricâte efecte de animaţie obiectelor 
într-un  diapozitiv,  cu  condiţia  să  nu îngreuneze 
prezentarea.  Lansaţi  comanda  Play,  din  panoul 
Custom  Animation  pentru  a  reda  animaţia 
asociată obiectului ales. 

• Eliminarea efectelor de animaţie 

1.  În  modul  de  vizualizare  Normal,  selectaţi 
obiectul căruia vreţi să-i eliminaţi un efect ataşat 

2. Alegeţi Slide Show → Custom Animation, se deschide panoul de activităţi corespunzător 

3. Clic pe butonul Remove.

15



5.8.2. Adăugarea efectelor de tranziţie între diapozitive 

Tranziţiile  între  diapozitive  sunt  efecte 
asemănătoare  animaţiilor  care  au  loc  în  vizualizarea 
Expunere diapozitive (Slide Show) atunci când se trece 
de  la  un  diapozitiv  la  altul.  Aveţi  posibilitatea  să 
controlaţi  viteza  fiecărui  efect  de  tranziţie  între 
diapozitive şi să adăugaţi sunete. 

• Aplicarea  unui  efect  de  tranziţie  unui 
diapozitiv 

1. În vederea Normal, selectaţi diapozitivul pentru care 
vreţi să adăugaţi un efect de tranziţie 

2.  În  panoul  de  activitate  Tasks,  clic  pe  fila  Slide 
Transition 

3. Selectaţi un efect de tranziţie din listă 

4. Alegeţi un tip de viteză din lista Speed 

5. Selectaţi un tip de sunet din lista Sound 

6.  Stabiliţi  metoda  de  trecere  la  alt  diapozitiv  din 
prezentare:  metoda  automată  sau  cu  ajutorul  mouse-
ului, sau amândouă. 
Notă:  Dacă  doriţi  să  aplicaţi  un  efect  de  tranziţie 
tuturor  diapozitivelor  clic  pe  butonul  Apply  to  all  
Slides 

• Eliminarea  unui  efect  de  tranziţie  unui 
diapozitiv 

1.  În  vederea  Normal  sau  Slide  Sorter,  selectaţi 
diapozitivul  căruia  vreţi  să-i  îndepărtaţi  un  efect  de 
tranziţie 

2.  Selectaţi  No Transition  din lista de efecte, din fila 
Slide Transition 

• Înregistrarea temporizării în timpul repetiţiilor 

1. Selectaţi vizualizarea de tip Slide Sorter 

2.  În meniul  Slide Show, faceţi clic pe  Rehearse Timing  (Programarea repetiţiilor) pentru a porni 
expunerea în modul repetiţie. 

3. Faceţi clic pe butonul de avans când doriţi să vă deplasaţi la următorul diapozitiv. 

4. Aplicaţia înregistrează timpii stabiliţi pentru fiecare diapozitiv. Salvaţi prezentarea. 

5. Dacă doriţi să se repete prezentarea automat lansaţi Slide Show → Slide Show Settings 

6. Clic Auto şi OK. 
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5.8.3. Lansarea unei prezentări – Slide Show 

OpenOffice.org  Impress  vă oferă  o  serie  de  variante  de  a  susţine  o  prezentare:  pe  ecran, 
interactiv, cu video-proiector, imprimări pe hârtie. 

Aveţi posibilitatea de a utiliza toate efectele speciale şi caracteristicile din aplicaţia  Impress 
pentru a face o prezentare pe ecran interesantă şi completă. 

Aveţi  posibilitatea de a utiliza  tranziţii  între diapozitive,  programări în timp,  filme,  sunete, 
animaţie şi hyperlink-uri. După ce decideţi că veţi utiliza un computer pentru a face prezentarea, aveţi 
diferite opţiuni pentru felul de a o face. 

Cea mai simplă modalitate de lansare în execuţie (expunere diapozitive) a unei prezentări o 
reprezintă  utilizarea  monitorului  calculatorului  propriu.  Lansarea  unei  prezentări  (expunerea 
diapozitivelor) poate fi realizată prin mai multe metode: 
- Lansaţi din meniul Slide Show → View Show. 

- Lansaţi din meniul View → Slide Show. 

- Efectuaţi clic pe butonul Slide Show aflat pe bara de instrumente Presentation 

- Apăsaţi tasta F5 

În urma lansării uneia dintre acţiunile de mai sus se va afişa prezentarea pe tot ecranul pornind 
de la diapozitivul curent al prezentării. În timpul prezentării trecerea de la un diapozitiv la altul se 
poate realiza printr-un clic (sau prin acţionarea barei de spaţiu sau a tastei Enter). 
Puteţi  folosi  şi  metoda automată,  dacă aţi  stabilit  pentru fiecare diapozitiv timpul de expunere.  În 
timpul lansării automate a prezentării, dacă vreţi să interveniţi, clic dreapta mouse, apare meniul de 
context, de unde vă alegeţi comanda dorită: 
- Previous – întoarcerea la diapozitivul anterior 

- Go to Slide – deschide lista cu diapozitive de unde puteţi 

selecta diapozitiv-ul pe care vreţi să-l prezentaţi 

- Screen – puteţi alege Black –ecran negru sau White – ecran alb, afişat la un moment în prezentare 

- End Show – încheiaţi prezentarea. 

Ce aţi învăţat în acest capitol? 

• Cum să aplicaţi efecte de animaţie obiectelor din diapozitiv. 

• Cum să stabiliţi un efect de tranziţie la trecerea de la un diapozitiv la altul. 

• Cum înregistraţi timpii de expunere pentru fiecare diapozitiv 

• Cum se lansează o prezentare. 
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5.9. Listarea 

5.9.1. Listarea unei prezentări 

1. Deschideţi prezentarea pe care doriţi să o imprimaţi. 

2. Lansaţi din meniul File → Print 

3. Se deschide caseta de dialog Print 

4. Specificaţi numele imprimantei la care vreţi să imprimaţi prezentarea 

5.  În secţiunea  Print range, alegeţi opţiunea  All, dacă vreţi să listaţi toate paginile,  Pages  - listaţi 
anumite pagini 

6. Alegeţi Number of Copies, mai mare decât 1 dacă doriţi mai multe copii ale prezentării. 

7. Clic pe butonul OK, lansăm listarea prezentării. 

5.9.2. Listare Handouts, Notes, Outline 

Aplicaţia  Impress  listează implicit toate diapozitivele fişierului prezentare. Pot fi listate, de 
asemenea următoarele formate: 
Handouts  (diapozitive  imprimate)  –  pagini  ce  conţin  mai  multe  slide-uri  pe  pagină,  ce  se  oferă 
auditoriului 

Notes  (pagini  cu  note)  –  pagini  ce  conţin  diapozitivele  însoţite  de  note  ce  documentează  fiecare 
diapozitiv 

Outline (schiţă) – pagini care conţin numai textele din casete de tip substituenţi. 

Pentru a lista aceste formate urmaţi paşii: 
1. Lansaţi din meniul File → Print 
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2. Se deschide caseta de dialog Print 

3. Clic pe butonul Options, se deschide caseta de dialog de mai jos 

4. Alegeţi în secţiunea Contents, opţiunea corespunzătoare tipului de conţinut. 

Notă: Dacă doriţi să stabiliţi şi alte opţiuni la listare decât cele implicite, în caseta  Printer Options  
puteţi alege opţiuni de calitate a listării - Quality, de elemente suplimentare de listat – Print şi opţiuni 
de pagină – Page Options. 

Ce aţi învăţat în acest capitol? 

• Cum să listaţi o prezentare. 

• Cum să listaţi prezentarea în format Handouts, Notes, Outline. 

• Ce opţiuni aveţi la listare . 
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